MICRO CT LUNG
SEGMENTATION

Using Analyze

QAnaIyzeDirect




MICRO CT LUNG SEGMENTATION 2

Table of Contents

1. Introduction page 3
2. Lung Segmentation page 4
3. Lung Volume Measurement page 13

4. References page 16

You


http://www.linkedin.com/company/analyzedirect
https://twitter.com/analyzedirect
http://www.youtube.com/analyzedirect
https://www.facebook.com/AnalyzeDirect

MICRO CT LUNG SEGMENTATION 3

Introduction

Mice are often used as experimental models of lung diseases, and measuring lung volume in vivo provides a non-destructive way to
determine changes in lung structure and function due to genetic variation or pathology'. The advantages of using mice as experimental

models include a short reproductive cycle, a well-characterized genome, and economic factors?.

Lung volume is related to aerobic capacity in the forms of oxygen diffusivity and consumption, and is linearly related to body mass?. Both
clinical CT" and x-rays® have been used to estimate lung volume in small mammals. Micro-CT has become more readily available than in the
past and it provides a higher accuracy of lung volume measurement for small animals such as mice, as well as enabling airway structure to be

studied at a higher resolution®.

This guide outlines how to measure lung volume from micro-CT data using Analyze.
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Lung Segmentation

Download the Analyze uCT Mouse Lung data set from:
http://analyzedirect.com/data/

Load the data set into Analyze (File > Load, then sele ct data set from
its location on disk). In the Analyze workspace, select the data set and

open the Spatial Filters module (Process > Spatial Filters).

In the Spatial Filter window, click on the Generate menu, then Filters.
This will open a window with a list of filters. Choose a Low Pass or
Median filter. For most PerkinElmer micro-CT data, a 5x5x5 or 7x7x7

kernel size is appropriate.

Once the filter type and kernel size have been selected, click Filter, and
choose to filter a copy of the loaded volume. The filtered data set will
appear in the workspace with a _LwP or _Med suffix, depending on the

filter type.

Filter Type
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) Unsharp
) Unsharp Enhance

(") Sobel Enhance
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Open the filtered data set in Volume Edit. o o

File View Other Help

Under the Semi-Automatic tab, select the B | ® 5=
L (Wi
Threshold option. Adjust the threshold

maximum to the maximum intensity value

Name Original

in the data set, and set the minimum color e[

Display Locked

Add Object

[

threshold value such that the entire mouse s e |

Browse

Connected Components () Object Extractor () Object Separator
h h H H h b H k Oblique Cutting Fill Holes Propagate Objects

Is shown as white In the binary mask, el

Specify a threshold range to define an object.

including the lungs.
12534 I |- £ <]

V| Thresh] Adjusts threshold range. Drag either

end to adjust max and min. Hold Alt
key down while dragging to allow for
fine tuning of values. Click in trough
o adjust by one, Shift-Click to adjust
by one in opposite direction.

Reset Se Undo

oy
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Click the Define Object button. This
will create a new object called Object_2
which will encompass the voxels

belonging to the mouse.

#+ Mouse_Lungs_LwP - Volume Edit

File View Other Help

B0 ® Sl

B Joriginal
1 [object 2

Nome|Object 2
Color Red =) Add Object
[ Display [ Locked o

[ Edge strength | walls| SEmI'AutumaU:lMaMa\‘

O Browse @ Threshold () Region Grow
Connected Components ) Object Extractor () Object Separator
Oblique Cutting Fill Holes Propagate Objects
Reassign Object

Specify a threshold range to define an object.

Min Threshold Max
12584 44338

[¥] Threshold Rendering
| Define Object
Reset Seeds Reset Limits Redo Undo
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Lock the Original object by clicking the
padlock icon to the left of the object. This
will limit new objects to the voxels that

belong to the mouse.

Turn off the display of Object_2 by clicking

the monitor icon to the left of the object.

Click the Add Object button to add a new
object. Then move the threshold minimum
slider to the lowest intensity level, and
lower the threshold maximum slider until
the lungs and outside of the mouse are

well-defined by the binary mask.

#+ Mouse_Lungs_LwP - Volume Edit

BN

File View Other Help
[ H [S
LI

& Joriginal .
L b2 |

Name| Object 2

Connected Components ) Object Extractor (©) Object Separator
Oblique Cutting Fill Holles Propagate Objects
Reassign Object

Specify a threshold range to define an object.

Min Threshold Max
7884 21615
] Threshold Rendering
[Define Object|
Reset Seeds | | Reset Limits Redo Undo

Culog| R=d =/ Add Object |
.
Display Locked ‘ jj‘
Edge Strength | Walls| Semi-Automatic |Manual
Browse © Threshold Region Grow
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Click the Define Object button to 2 Mo o N 5

iﬁ View Other Help

define Object_3. It should primarily be

comprised of the lungs and the skin.

Name| Object 3

Color Green Add Object
Display 7] Locked

Edge Strength Semi-Automatic

© Browse Thresheld

) Region Grow

) Connected Components ) Object Extractor

*) Object Separator
©) Oblique Cutting © Fill Holes © Propagate Objects

) Reassign Object
Specify a threshold range to define an object.
Min Threshold Max

| 7es ] shass |

Threshold Rendering
| Define Object
Reset Seeds | [ Reset Limits Redo
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Now lock Object_2 and turn off the

display of Object_3. Select the Region

Grow radio button under the Semi-

Automatic tab.

Name Original

Color [White ‘i J h\
Click the Add Object button to add a i (A 3

] Use Edge Strength

new object, Object_4. Click on one of

AR

the orthogonal images to set a seed

point in the lungs. The same threshold
range defined in the previous step will
be retained. Click Extract Object, and

rename Object_4 to Lungs.

 Copyrignt 1986:2014, BIR Mayo Ci
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To separate the trachea and the bronchi

from the lungs, the Object Separator
tool can be used. Under the Semi-
Automatic tab, choose the Object

Separator radio button.

Click Add Object to add a new object
and rename it to Trachea. To separate
the objects, select the Trachea object,
then click on either the rendering or an
orthogonal image to set the first seed
point on the trachea. Click again in the
lungs to set a second seed point. Then
click Separate. It may take several
iterations of this process to separate
most of the trachea from the lungs.

#+ Mouse_Lungs_LwP - Volume Edit

File View

Color |Blue

Display

w5 5m
i al

Other Help

[ Locked

(225, 208, 314) Valus=1407 (Objsct=Lungs)
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Manual tools can be used to further refine i Ve Ligs Lot olume £

File View Other

L R

Original
5 object 2
B Object 3
[ JLungs

Ol [rachea

the separation between the lungs and the

bronchi. The final segmentation is shown

in the render window.

Name| Trachea

Color |Biue
Display [7] Locked
1§

Opacity 0-100%)| 50

Edge Strength [ Walls| Semi-Automatic |Manual
Browse O Threshold ~ (© Region Grow

") Connected Components ) Object Extractor @ Object Separator

*) Oblique Cutting ) Fill Holes ©) Propagate Objects
) Reassign Object

Select two points on the same object. The first
point selected ill become the specified object.
Selecting points on orthiogonal images has
proven to be more efiective than selecting
points on the rendering.

Reset Seeds | | Reset Limits Redo Undo.

206 25

Point Ficied = (234, 198, 312) Value=1435 (Object=Lungs)
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If you wish to visualize the bone structures
surrounding the lungs, these can easily be
segmented as a separate object. The red

object will have to be unlocked. Then use

the Threshold tool to define the bones at

the top of the threshold range.

Change the colors of the objects by
clicking the palette icon to the right of the
object color when each is selected, orin
the Objects window (View > Objects).

In this example, the lungs, trachea and
bronchi were all set to the same pink
color, but they can still be separately
measured since they are defined as

different objects.

Save the object map (File > Save Object
Map), then close the Volume Edit module.

#+ Mouse_Lungs_LwP - Volume Edit

File View Other Help

B0 ® Sl

:
W trachea
W[ Jeones

Name|Lungs

Color [#tibtf [ Add Object
Display ] Locked
L[]

Opacity 0-100%)] 50

Edge Strength | Walls| Semi-Automatic |Manual

Browse ® Threshold ) Region Grow
Connected Components () Object Extractor ©) Object Separator
Oblique Cutting ) Fill Holes ©) Propagate Objects

*) Reassign Object
Specily a threshold range to define an object:

Min Threshold Max
21144 44338
Threshold Rendering

Reset Seeds | [Reset Limits Redo

Point Ficied = (234, 198, 312) Value=1435 (Object=Lungs)
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Lung Volume Measurement
Open the filtered data set in the Region of Interest module BEF Monrse Lungs L - Reie (R Raee . E=REE=)
(Measure > Region of Interest). Load the object map by sl ity e mlin
navigating to File > Load Object Map. 2 ﬁ i ?,‘:,‘1“3" .Hy.,'!.')HpH _)H & BT
Adld
O] P4
]
Sample
Images
Clear
Regions
Clear
Lirnits
| Stice I : _ _|_| _ .-321
I::/E“ (_'1'_) Edit o
'—'E"j e :fe @ EIRDL % %
i) e EEJP t oy
ﬁ NO @ Eomlerf E¥ . .5&;‘\“&; % M

Intersections become part of: Object To Define:

@ Defined () Existing (0) New Ny T

™) 2D Mode @ 3D Mode ) 4D Mode
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To open the measurements tool, click

Generate > Sample Options.

In the Sample Options window, set the

following parameters:

e Sample Type to Object(s)
e Select the Lung Object

¢ Summing to On

e Sample to All Slices

* Sequence Display to Off
¢ Log Stats to On

Click on the Configure Log Stats button.

The ROI Stats window will open, showing

the measurements that can be generated.

Uncheck the Area measurement.

' - ™
#. Sample Options - Region Of Interest A E@g
i
Sample Type *|[[] original
() Selected Region [F] Object 2
& Obyecifs) [7] Object_3
) Individual Voxels Lungs
[ Trachea
- |[C] Bones
’ Select All ” Invert Selections ]

Combine Objects: @ Mo () Yes

Minimurn Sample Max/Min

788 [_]

Maxirmum
| |[4338

Range @ Volume () DataType
Volume @ Primary = Related

Summing @ ©
> onc
Auto Reset @ On () Off

Sample @ All Slices () Slices Specified in Slice Menu

Sequence Display ) On @ Off

Stat Type @) Intensity () 2D Shape (7 3D Shape () Fractal

() Boundary Coordinates (*) Region Pixels

Decimal Places 2

Log Stats @ On () Off

Configure Log Stais]

(4. ROL'Stats - Region Of mmml;glﬁlg’

Plot Leg

File = Mouse_Lungs_LwP
Object Map = Mouse_Lungs_LwP_screenshot_final
Vol. No. =1
Slice=1
Region Name = Original_sum
Maxirmum = 0.

at(l,1,1)
Minimurm = 99999,

at(1,1,1)
Mean = 0.
5t. Dev. = 0.

Sum = 0.

Entropy = 0.
Mumber Of Voxels = 0
§ Area = 0. mm2
¥| Volume = 0. mm3
<JEBE =10
> 4338 =0
>=TJBB BL<=4338=0

15 = T = = £ =

]

[7]  MeanIn Range = 0.

[] st.Dev.InRange=0.
[]  SumInRange=0.

[T]  Arealn Range = 0. mm2
O

Volume In Range = 0. mm3

OoOoO0OoOoOOooOooOoOoooOoE O O

[F] BAP=O.
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Back in the Sample Options window, click on the Sample Images button. The measurement results will appear in a new window called “ROI

Stat Log.” The measurements can be saved from this window using the Save button or by right-clicking in the window.

£ T B
#+ ROI Stat Lag - Region Of Interest = =] = |
¥ Wed Dec 10 14:532:08 CST 2014 i
# VolumeFile= Mouse Lungs LwP
# SampleMax= 4338 SampleMin= THE8
¥ VoxelWidth= 0.05808908006908808837 VoxelHeight= 0.03890000890000808008087 VoxelDepth=
¥
# Vol # Slice Name Mean S5td.Dev. Voxrels Vol mm3
3

1 5035 Lungs _sum 1437.38 F2.51 2696591 553.82
4| m b
| | Done
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